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The Photoelectric Effect 
Spring 2025  

Introduction  
In early experiments that attempted to create radio waves, it was noticed that light shining on an electrode 

sometimes produced a visible spark. Later experimentation found that these sparks were created by the impact of 
light on an electrode, which caused the ejection of electrons. It was also found that these ejected electrons had 
kinetic energies that increased linearly with the frequency of the light used.  

These observational results were explained by Einstein assuming that light behaves as a particle. This model 
predicts that the maximum kinetic energy, Kmax, of ejected electrons depends only on the frequency (color) of the 
incident light and is independent of the intensity. Therefore, the higher the frequency of the light, the greater the 
energy of ejected electrons. 

In contrast, the classical wave model of light predicted that Kmax would depend on light intensity – the brighter 
the light, the greater the energy of the ejected electrons. Today’s experiment will test both theories. 

Theory  
The apparatus consists of a mercury source behind a slit, a diffraction grating and a lens which images the slit in 

the wavelength of each mercury line on a phototube (Figure 1a). The photons strike a metal plate inside a capacitor, 
causing electrons to be ejected (Figure 1b). These ejected electrons charge the capacitor to roughly their highest 
energy, so the measured voltage (also called the stopping potential, Vstop) gives us a measurement of the energy of 
the ejected electrons.  

 

 

Figure 1a: The apparatus Figure 1b: Photoelectric head detail 

Each photon has energy E = hf, where f is the photon frequency and h is Planck's constant. When a photon 
strikes a metal surface, a minimum amount of energy, φ (the work function), is needed to knock an electron off. The 
remainder is given up to the kinetic energy of the ejected electron.  

Kmax = hf – φ  

These electrons strike one of the capacitor plates and charge it up. Eventually, the capacitor voltage becomes 
large enough to stop further charging. This happens when  

Kmax = eVstop  

where e is the charge on an electron. Setting up this equality gives us:  

eVstop = hf – φ {Equation 1} 
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Figure 2: Grating detail 

We can measure Vstop and calculate f for each of the given mercury wavelengths (c = f λ). Equation 1 is in the 
form of a straight line, y = (slope)x + b. From the slope we can find Planck’s constant and from the intercept we can 
find the work function, and hence the binding energy of the electrons.  

We will use the electron-volt as a convenient energy unit for the quantity eVstop. An electron-volt (eV) is defined 
as the amount of kinetic energy gained (or lost) by a single electron accelerating from rest through an electric 
potential difference of one volt. That means that if you measure 1.234 volts for Vstop, the ejected electrons have 
gained an energy of 1.234 eV. 

Experiment:  Caution – The mercury lamp is very hot. Do not turn off the lamp until everyone 
at the table is ready to leave! 

1. Create a data table in your journal with the following columns, which includes three measurements of Vstop 
for each color. Recall that the quantities in angled brackets (< >) are the average values: 

Line Color λ (nm) f (Hz) Vstop 1 (V) Vstop 2 (V) Vstop 3 (V) <Vstop> (V) <eVstop> (eV) 

2. Calculating Line Frequency: The wavelengths of the brightest mercury lines that you will measure are 
listed below. Calculate the frequency of each line in the table, in units of Hertz (Hz). Keep four significant 
figures and be careful with the units! 

Color  Wavelength (nm)  
Violet #1  365.0 

Violet #2  404.7 

Blue  435.8 

Green  546.1 

Yellow  578.1 

3. Press the power switch on the side of the photoelectric head to turn it on. Record the letter (A – I) on the 
back of the photoelectric head on your apparatus sketch (the results you get will depend on which photo 
head was used).  

4. Measuring the Electron Energy Dependence on Frequency: Light from the 
mercury lamp passes through a ‘blazed’ diffraction grating (Figure 2), which 
maximizes the efficiency of the grating for specific wavelengths. A blazed 
grating produces images that are brighter on one side of the zeroth order image 
than the other. The apparatus has been set up so that the brighter images result 
from pulling the photoelectric head towards you. Use the following procedure to 
measure the stopping potential for each of the five colored spectral lines: 

a. Pull the photoelectric head towards you until the first violet line is aligned with the slit on the white 
reflective mask. 

b. Roll the cylindrical light shield of the photoelectric head out of the way and look inside to see the 
white photodiode mask. Loosen the thumbscrew on the support rod under the photoelectric head and 
rotate the head until the image of the violet line is centered on the window in the photodiode mask. 
Tighten the thumbscrew when you have the correct alignment and close the light shield. Careful 
alignment is very important for your measurements; ask your instructor if you need assistance. 

c. Press and hold the Zero button at the center of the photoelectric head control panel until the 
voltmeter reading is 0, then release the button. Record the stopping potential in your data table when 
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the reading on the voltmeter stops increasing. Repeat this step to collect a total of three voltage 
measurements, zeroing between each measurement, and then calculate the average, <Vstop>.  

d. You will now see the ejected electrons dependence on the light frequency. Move the photoelectric 
head to the next line and repeat the alignment and measurement procedure. Place the green filter so 
it covers the slit on the white reflective mask when measuring the green line, and the yellow filter for 
the yellow line (no filter is required for the violet and blue lines). These filters limit higher 
frequencies of light due to the second order image from entering the photoelectric head.  

e. Fill in the values for <eVstop> in your data table. 

5. Graph #1 – Plotting Frequency Dependence: Plot <eVstop> vs. f in Excel using the stopping potentials you 
just measured. Since it has been a while since we created a graph in Excel, here are a few tips and hints: 

a. You need to select both the <eVstop> and frequency columns from your data table to create your 
graph. These columns are not next to each other, so you need to use a modifier key when selecting 
each column. Read “Creating a Graph” (step 5, page 2) from Graphing and Curve Analysis Using 
Microsoft Excel to see which modifier key is used for your computer (Macintosh or Windows). 

b. With both columns selected, click the Insert tab and then choose a scatter plot. 

c. Select the graph, then from the Design tab click the Move Chart button and then choose New Sheet. 

d. Enter an appropriate title (containing the quantities that are plotted) and add axis labels (Design tab 
→ Add Chart Element → Axis Titles → Primary Horizontal and Primary Vertical) 

e. Add a best-fit line by right-clicking on any data point and choosing Add Trendline. Click the button 
next to Linear and click the box next to Display Equation on chart. Don’t close the Format 
Trendline options section yet! 

f. We wish to make our graph look like the one on the blackboard. The line fit can be extended beyond 
the end data points in Excel by increasing the backward forecast: In the Forecast section, type 6E14 
next to Backward, and then press Enter. 

g. Set the horizontal axis so that it starts at the origin: Right-click on any number along the horizontal 
axis and choose Format Axis. In the Bounds section type 0 next to Minimum, and then press Enter. 

h. Increase the font size of the fit equation by selecting the equation box, clicking the Home tab, and 
changing the font size to 14. Move the equation so that it does not overlap the best-fit line. 

i. Note that the value displayed for the slope only has one significant figure. Increase the number of 
digits displayed by right-clicking on the line equation and choosing Format Trendline Label. In the 
Number section, choose Scientific in the Category section, and change the number of Decimal places 
to 3 (note that this will give you a slope with 4 significant figures). The intercept becomes formatted 
as Scientific as well. 

• If the number of significant figures did not change, unselect “Display Equation…” in the 
Format Trendline window, and then select it again. 

6. Your data points should follow the best fit line well. If a point deviates significantly, check your 
calculations, and make sure you have measured the correct mercury line. Use the results of the linear fit 
from your graph to calculate Planck’s constant and the work function.  

The published value of Planck’s constant is h = 4.136×10–15 eV∙s, and the manufacturer of the photoelectric 
head gives the work function φ = 1.36 eV. Calculate the % difference for each. Check with your instructor 
that your results are consistent for the photoelectric head that you used! 
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Now you will test the classical wave theory assertion that light intensity affects the energy of an ejected 
electron. 

7. Ejected Electron Dependence on Light Intensity: You will now vary the intensity of a single color of light, 
instead of varying the light color (frequency). You will use a relative transmission slide, which has five 
sections allowing from 20% (minimum intensity) to 100% (maximum intensity) of light to pass through. 

a. Create a new table in your journal, with the following columns. Again, you will take three 
measurements of Vstop for each of the five intensities you will examine: 

Line Color Relative 
Transmission (%) 

Vstop 1 (V) Vstop 2 (V) Vstop 3 (V) <Vstop> (V) <eVstop> (eV) 

b. Using just the yellow line (with the yellow filter), repeat the alignment and data collection procedure. 
Record three measurements of the stopping potential for each of the five regions (100%; 80%; 60%; 
40%; 20%) on the variable transmission slide. Note that you can stack the transmission slide on top 
of the yellow filter, moving the transmission slide over for each series of measurements. 

• Note: Enter the Transmission as numbers (e.g., 100, 80, 60 …), not percentages! 

c. Calculate the average stopping potential and <eVstop> for each of the five opacities. 

8. Graph #2 – Plotting Intensity Dependence: Plot <eVstop> vs. %Transmission. As before, here are some 
graphing tips that will make your graph easier to analyze: 

a. Select the Relative Transmission and <eVstop> columns as you did for the previous graph.  

b. Create a scatter plot of this data as before. Again, move the chart to a new sheet, and add a title and 
axis labels. 

c. You will again change the range of the vertical axis scale, as you did previously in step 5g. This 
time, set the Minimum value to 0 and change the Maximum value to 2. 

d. Do not fit a trendline to this data.  

Discussion 

• Record the curve fit equation from the first graph, along with the appropriate units of the slope and 
intercept. 

• Record your value of Planck’s constant and the binding energy of the electrons in the phototube.  

• Briefly discuss the agreement between your values of h and φ for the photoelectric head that you examined. 

• Briefly describe what you discovered about the dependance of the kinetic energy of ejected electrons 
(which is proportional to eVstop) on frequency (the photon model) and intensity (wave theory). Be sure to 
discuss the differences between your two graphs, and how each graph supports – or does not – each theory 
of the behavior of light. 

PLEASE TURN OFF THE MULTIMETER 
AND FLASHLIGHT WHEN FINISHED! 


